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What is C3D c3D

Cancer Central Clinical Database

e Clinical Trials Data Management System

e RDC (Remote Data Capture) Data Entry

0 Accessible anywhere in the world (via a Windows computer and
Internet Explorer).

a For studies prior with Clinical Center Number prior to 2012: The Java
Runtime Environment (JRE) version 1.7.0_45 (or later) is required.

0 The above requirement will no longer apply by mid-2017, when open
studies setup in C3D before 2012 will be converted to a new interface —
‘RDC Onsite’.

e C3D supports data standardization, reuse, sharing, and
Interoperability through electronic Case Report Forms (eCRFs)
based on Common Data Elements (CDES)

e Based on Industry Standard Technologies
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C3D Organization

[ C3D Project }
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Designing Protocols in C3D

00000
Kﬁﬁﬁﬁ

Control & Configurations Management Group (CCMG)

P VLY O N

Protocol Requirement Initiation Forms & Rules Forms & Rules Activation Report Change
Receiving Specification Meeting Building Testing Meeting Building Request
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Rep Doc]| Rep Doc|
| Signoff | | Signoff | | Signoff |
| QC Doc | | QC Doc | | QC Doc | | QC Doc |
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CCR Standard Case Report Forms

e Library of Standard Forms & Rules is available as a starting
point to build protocol specific forms & rules

e Detailed Instructions are available for each Standard Form

e Each Instructions includes:
0 General Description
0 eCRF Screenshot
o Field Specific Description (Mandatory, Derived, etc.)
0 Validation/Derivation Rules


https://ccrod.cancer.gov/confluence/x/9QiJAw

eCRF Instructions Manual

Course Initiation

Home  C3D Portal Training and Education Course Initiation
Home Contents
C3D Portal + Purpose
e Course Initiation eCRF

Login « \alidations
Training and Education + Derivations
Sponsor Reporting

Support Purpose

o Record course initiation Start Date, Arm, Treatment Assignment Code (TAC) and Treating Institution.
Other Applications

Documentation
Course Initiation eCRF

GLC Web Application
Users Manual

TIGER-LC Web =]
Application Users S———
Manual o
b Lan o Lonrna |
[ ID - E :‘ P,
Field Name Description / Instructions Format
Visit Date!™ Enter the date the course started. DD-MMM-YYYY
Course # Sequential number of this course of treatment: first course = 1, second course = 2, etc. 5 digits
Start Date of Enter the date on which the course was started. This is the date on which a protocol stipulated
o o ' P P DD-MMN-YYYY
Courge'™ medication (or treatment) was first administered.



CCR Standard Case Report Forms

e Screening/Baseline Forms

a Eligibility, Enrollment, PE, Vitals, Baseline Symptoms,
Prior Therapies, ...

e Courses/Cycles

a Course Initiation, Study Medication Administration, PK,
Course Assessment, PE, ...

e Labs

0 Blood Chemistry, Hematology, ...
e Ongoing

a AE, Concomitant Measures, Extent of Disease, ...
e Off Tx / Follow-Up / Off Study
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C3D Protocol Phases

C3D Study Phases

Patient on Treatment

Ongoing / AE & Concomitant Meds

s A \
On Treatment Off Treatment Off Study
b H H
Screening Protocol Baseline Course 1 Course 2 Course n Follow-up
_____________________________ T |

Labs / Procedures
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Role Based Access

Access => Enter Data Manage Approve
Discrepancy eCRF
Role
Pl Yes NoO No No No
Research Yes Yes Yes Yes No
Nurse
Data Yes Yes Yes No No
Manager
Monitor Yes No Yes No Yes
QA Yes No No No No
Prqtocol Yes Yes Yes No No
Builders
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NCI/CCR Confidentiality Agreement —
Training Certificate

e At the end of the Training session, print, sign and fax
the CCR Confidentiality Agreement to 240-541-4435.
You can also scan and e-mail it back to the Trainer.

e Upon receipt of the CCR Confidentiality Agreement:

e The request for your C3D account, password and access
will be submitted. The C3D Help Desk will provision your
C3D account within 2 business days.

e The Certificate you attended the training will e-mailed to
youl.

e Keep your signed CCR Confidentiality Agreement and the
Training Certificate in your Study’s regulatory binder.
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C3D Support

CBIIT provides the first line of support for C3D related
Issues

Contact
o Email;

0 Phone: 240-276-5541 (Toll free: 888-478-4423)

o Telephone support is available Monday to Friday, 9:00 a.m. to 5:00 p.m.

Eastern Time, excluding government holidays.
o Additional Information at:

Protocol specific issues are escalated to the Protocol
Builder by CBIIT

Changes to Standards are escalated to Controls &
Configuration Management Group (CCMG)
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Username & Password

e Username is typically your last name and first name Iinitial.
Ex: smiths

e Password rules:

Q
Q
Q
Q

Start with a letter;

Must containing at least one number and one special characters (Ex:! #);
Has to be at least 8 characters long;

The following special character could cause problems ifused: $% & ‘' /.

e Production Database is called ocprod
e About C3D Password:

Q

Q
Q
Q

Do not share the password with others!
Password needs to be changed the first time you login.
Passwords expire every 4 months and need to be changed.

Account gets locked upon three unsuccessful attempts. Contact C3D Help
Desk to unlock account and/or get new password.
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C3D Login Web Pages

e C3D is Accessible Worldwide

e C3D Production Login Page:

e C3D provides a separate Data Entry
environment to test protocol design
a Test Login page:
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https://octrials.nci.nih.gov/opa46/rdclaunch.htm
https://octrials.nci.nih.gov/opa46/rdclauncht.htm

C3D Login Web Page

For studies with NCI Clinical Center Number prior to 2012
(ex: 11 _C 0001, 10 _C 0002), click on the Login button.

<16

|2 https:ffoctrials.nci.nih.goviopadbfrdclaunch.ht O - @ & X

p .
(= Oracle Clinical ...

O Mational CancerL..

M CCR Clinical Inf

ORACLE

HEALTH SCIENCES

Oracle Clinical Remote Data Capture 4.6

[ RDC Onsite ]

Change Password

Login help

Health Sciences Docume

Online

RDC Online Help Home

Downloads

Oracle Health Sciences

Oracle Healith Sciences |

Group

Click on Login Button
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Oracle Developer Forms Runtime - ¥Weh

T o ey

an:ugn:un >

usernarme: [ INEGNGTNN
Fassword: |
Database: [N

Connect

Enter User, Password, and Database.
Then click Connect




C3D Activity List

E\E-_%Deven Shah(Data management role) at OCTRN on 19-1AN-2006 (Study:TRAINING Site:NCI Book:Dci_Book_Jan_2006)

File Edit Ins Aty ate ORACLE
SR G A SN = ?

AT e | Review 1 Active Discrepancies A
o Site: NCI Show All Data for TRAINING \
L4 Feview 1 Active Discrepancies far Site NCI
2 0
-3 .
4 B =
. \
5
6
7
g -
B LoadFiter || -
10 -
11 Change Study ::
12 Search
—13 -
L 14 Cancel
—15 Help
L =] —]

T o7

Study CRF Information

Plarned Mot verified
]

Study Information
Moaiting re-verification

Mame [ Training study for ternplate\l’.‘kz\
Total verified | 0]

g
L1

With active discreps E Mot approved -
9

Created Enralled With Data With ather dizcreps Anaiting re-approval [j] Locked [j]

Clean 0 Approved 0 Mat Locked 1 u

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, 4

Unplanned

Patierts | a0 [ | (
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Selecting Activity

e Quick Links to View
o All Study Data
0 Discrepant Data
0 Site Specific or Patient Specific Data

e Change Study button to choose a Different Study
0 Default Study is preserved from prior login
0 Access to study sites and C3D features are controlled by user role

e Search button used to locate eCRFs based on one or more
criterion

e Quick Tip:
Q Tthig screen provides a quick review of open discrepancies in your
study

o Itis strongly recommended to work with one patient at a time
when performing data entry to avoid entering data in the wrong
patient position.
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Selecting Study

E%i[)even Shah{Data management role) at OCTREN on Z8-FEB-2005 (Study:TRAINING Site:SITE_ 01 Book:Dci Book)

File Edit Insent CRF g Walidate Help window ORACLE
o

-

’5‘_5 QIran

Find

Study Mame | Title
030038 03-C-0038 (A750) - Dr. Janik

02_c_0o0s Study 03-C-000%5 - Dr.Phil Arlen

02_c_0018 03-C-0018 - Dr. Howard A. Fine

02_c_0030 03-C-0030 {54830 - Dr. Susan Bates
02_c_0037 03-C-0037 (55400 - Dr. JoAnne Zujewski
03__0040 03-C-0040 (5762 - Dr. Claude Kasten-Sportes
023_C_0096 03-C-0096 (57480 - Dr. Wyndham H. Wilsan
02_c_0110 03-C-0110- PDMS Migration Study

03 < 0142 03-C-01452 - Dr.Claude Kasten-Spores
03_c_014a7 03-C-01&87 (37900 - Dr.wWilliam Dahut
02_Cc_ 0176 03-C-0176 {59113 - Dr.Phil Arlen

02_c_0194 03-C-0194 {4553 - Dr. John Marris

03 < 0228 03-C-0228- Dr. Sam Hwang

03_c_0281 03-C-0281 - Dr. Alexander, Anakinra
03_C_0284 03-C-0284 - Dr. Susan Bates

03_c_0300 03-C-0300 - Dr. Libutti

02_c_0304 03-C-03204 - Dr.vWyndham H. Wilson

SUMmary 04 0011 04-C-0011 -Dr, Tito Foio — .
Select Study & Click OK

| Activity List
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Study Access

e Study/Site access and C3D features
determined by user role

e User Roles:
o Data Managers (Performs Data Entry)

0 Research Nurse (Performs Data Entry and Verifies
eCRFs)

a Monitor (Read-only access and Approves eCRFsS)
a Principal Investigator (Read-only access)
0 Reviewer (Read-only access)

22



earch Criteria

] f i Jan_2006) ] 3

File Edit Insert C i Validate Help W ORACLE
RSN = ?
g Remote Da ture

Screening T

1Mo inits) e . Search Criteria Dialog Box

Dci_Book_Jan_2008 Default Book J I I
Patierit 1 All Patients

<l

Activity List Site NCI, Patient 1
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Search Criteria

e Search options:

0 Book - collection of CRFs for a particular version of the protocol (initial
version or amendments)

o Site
o Patients
o Range of Patients
o Visits/Pages
o Phases, Visits, etc.
o CRF Status
o Complete, Discrepant, Verified, Approved, etc.
o CRF Entry Date Window
o Entry or Modification Date Ranges

o Data
o Data entered in an eCRF

e Quick Tip:
0 Protocol Amendments may require different DCI Book. Latest DCI book is
the default one. Use Search option to select a previous book.

o Search Criteria Could be saved for future use.

24



RDC Spreadsheet

E%,%Deven Shah{Data management role) at OCTRM on 0Z2-MAR-2005 (Study:TRAINING Book:Dci Book) |

File Edit Insert CRF Group . DRACL
Pull Down to view eCRFs : » ..

TN e« by Phases or Visits | Pull Down to view additional Visits t~_ =

| [

".;_E Oracle Clinical Remote Data

AR LU

Creening
) i

= Course 1

LI1 ering L) ‘ ‘ * Screening

1-10 s e e o = Course 2
N = Bloo emi
1 (SAH) Each column represents | | oot
e = = Phases or Visit tabs a planned eCRF - Bone Marrow
5 (SAH) %” %” across the top | | g | " Sersloay
6 {SAH) %‘E %’E I I I E' I I = Blood Gas
o [ — = An Icon indicates the eCRF | pumonay test
= = | | =t T———— has been created for the Other Urine
8 (saH) T~z — . == = corresponding patient Immune Parameter
=% Patients down the left |. 2 L Serum Electrarh
9 (CD) E=nq Lrine Electroph
== I=E&1 =81 |l | i | Cther Labs
A | =1 = | = | | = = Ongoing
=0 =0 Offtrestment
A : T s .
ActivityList | Al patients, all pages Active Filter Offstudy
[ SUMMmEry

tvmary of CRFs Retrieved Summary of CRFs in Current Tab

Summary For # Patients .
Display summary information —

about a Visit, a Patient, a Planned

Total Yerified

eCRF or the selected eCRF.
With active discreps TIFT ST e T o | T ot approved
Witk ather discreps :] Ayvaiting re-approval E With other discreps E Ayvaiting re-approval

Je

Clean 167 Approved :] Clean Approved
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Navigating RDC Spreadsheet

e Spreadsheet Layout
o Patients along Rows
0 Phases or Visits Tabs along Columns; pull down for additional
VISItS
a eCRF within Tabs
a Cells represents an eCRF for the corresponding Patient-Visit

e Tabs can be organized by Study, Phase, & Visit

o  When working with Lab eCRFs, choose to work with Visits instead of Phases or
Study.

e Information Tabs for Summary, Discrepancies, Verification,
Audit-trail, etc. at the bottom

e Navigation Functions via
a Menu
a Toolbar
a Hot Keys

26



eCRF Icons

T ROC Topics

lcon Explanation
Blank Createc & tHed Entryc stared Pazz 2c

Ertry Status: .-

Dizcrepancies:

Yerification: L e
Fe-verification

Fequires

Approval;

Locking:

27



Important eCRF Icons

e Square icon represents manual entry
e Round icon represents automated entry (lab load)

e An eCRF just created, but without data has no lines
within the icon

e Partially entered eCRF has lines across half of the
icon
e Completed eCRF have lines across the whole icon

e Blank Square icon indicates eCRF has been marked
blank

e Red icon indicates one or more open discrepancies

28



Electronic CRF (eCRF)

Eﬁjﬁ'OPA (Marcelo Fontinha - OPS$FONTINHMT at OCPROD on 15-JUN-200-1)

Eile Edit Inset CRF Group. ate (]|

GO XDBR 6 P =

| Femote Dat R e e e e e e e T T T T T

Screening [ Course 1

- Course 2  Course3 Courzed Course S  Blood Chemistry  Hemstology Urinalysis Bone Marrovy . Serology  Other Serum Blood Gas
| Patient X2 Page 2 (Enroll for Screening) Page 1 of 1. e
Wigit Date 10-Jun-2004 Blark [ Comment |

Enrolt || Init_ts | COb B

Blank [ - \ M

X1 {XYZ)

X2(XYZ)
Tabs for eCRF
rit 5 =
X3 (xvZ - Non-enterable field
e Sections
WA XYL} Gender IETFHE of Birth ID1 -JAR-1373 Age ot Entey Patient Intials ABC
Diate of Registration 02-JAN-2004 Diate from wwhich to Start Including Labs O5-h2y 2003 =
X3 YT R
O (XVZ) | Race: Select all that apply El | | pSiS indicates iriicity |NONHISPANIC
White . . - Egistering Institution =
X0 XV EZ 1 1
¢ ! Blackftfrican American fleld haS a PICk LISt bcal Patient 1T YeIIOW - U n IVarIate
Mative Hawaiian/Pacific |slander |N_ Patiert Subgroup Dlscre pan Cy
Azian |N7 Registering Group e | »
Activity List | American Indian/laska Mative |N7 Country Code AR
Summary Race Mot Reported |N7 Postal Code
Race Unknown |N_ hethod of Payment S5=
Primary Dizeasze Site MSCULOSKELET AL Dizeaze Code 10000537 Dizea=ze Stage at Entry STAGE N A \

Histology/Cytopathology |xyz

Date of Confirmation of Histalogy Gracde of Histology 2
Date of Diagnosis Planned TAC |ARM 2
Diate Informed Consent Signed 01 -JAM-2003 Diate of Informed Conzent Wersion 1 2-DEC-2002

eCRF Scroll Bar
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eCRF Navigation

e Clicking on eCRF icon open the eCRF

e eCRF may contain tabs for the different
sections of the eCRF

e Grey Flelds indicates non-enterable fields
(Derived, Defaulted, etc.)

e eCRF Scroll Bars indicate additional information

e Ellipsis indicates the field has a Pick List. Click
on the ellipsis or press F9 to display the Pick
List.
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Audit Trail

ugMarcelo Fontinha(Data manageme le) at OCPROD on 17-JUN-2004 (Study:TUD312 [T] Book:Whole Book)

Eile Edit Insert

*ﬁpl@%ujﬁIﬁm

ORy

XA (XNE)
X2 (XNZ)
= Blank [~ Comment |
X3 (XNE)
o
XA (XNE) Bilank [
X8 (XVZ) Courze # Course Priar Date of Cn=et Date Resalved CTiC Term CTC Cateqory -
1 31 @ |- n-res-2003 Acute vaseular ek syndror
X9 (XYZ) 2 25 u 01 -MAR-2003 Apnea
= A T T _ _ - _
KXY Z) |—'E i 3 2 Il 02-tAR-2003 11 -Jam-2004 Amylase
] -
List All patients, all pages I e ¥
At Trail
Allaes

Intervening

eCRF specmc Audlt Trail

L|m| o L E— L e

Irrerit 3
=Row Deleted=
<o Deleted=

Action to adverse eve 1=MOMNE
Action to adverse eve 2=REDLICED

02-JUr-2004 15:30:46
02-JUR-2004 1553644

Attribwtion 1=UMNRELATED =Row Deleted= 02-JUM-2004 15 30:46 |Liming WWan Llpdate D Show
Attribwtion 2=LIMLIKELY =Row Deleted= 0Z-JUR-2004 15 3644 |Liming YWan Undate 0 || Show
|Ciate when the episode =Row Deleted= 02-JUM-2004 15:30:46 [Liming Yan Upiclate 0 || Show
Diate when the episode =Row Deleted= 02-JUIM-2004 15:36:44 |Liming Yan Lpdate 0 || Show
Dy in course 31 02-JUM-2004 15 36:44 |Liming YWan Resequenced |0 | Show | ~
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Audit Trail

e Audit Trail Tab shows history of all changes
made to a specific eCRFs

e Shows current and prior values for each
changed eCRF field along with the date of
change and the user who made the change

e Quick Tips:
0 Auditing Begins after Form is marked complete
a Do not share user ids and passwords!
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Resizing eCRF Window

"4 OPA (Marcelo Fontinha - OPS$FONTINHMT at OCPROD on 15-JUN-2004) =10l x|
File Edit Inset CRF Group Activities validate Help Window ORACLE
GO XMHB I H bl S &l 2

’5/Oracle Clinical Remote Data Capture

AllAes
X1 (XYZ) % Sizing window for Data Entry
x| Click Title Bar to enter
X3 (XVZ) Resize Mode

B then click the [Done|

X4{XVZ) hutton

A future alternative is to use the right mouse on the title bar

X8 (XVZ)

| e bone Then Click and Drag
X10 (XV2) the Title Bar to move
the window or the

: sides/corners to resize
ActivtyList Click Done when
Summery resizing is complete
Summary For

CRF -

Date [16-Apr-2004 [ Doc # [R11035201

)

Last modified an [1 F-Mlzy-2004 09:43:10

Status [Ertry Started Last transaction on [17-May-2004 03:43:10 ]

By [Liming Whian

Record: 171
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Resi

zing eCRF Window

e Click on the eCRF title bar to enter resize

MOQC

e

e Click and drag title bar to move window

e Click and drag window edge to expand/
reduce window size

e Click OK when Done

e Quick Tip:
0 Right mouse click on the eCREF title bar to show a pop-up menu
with options to move/resize the eCRF window.
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Log Out

File Edit Insert CRF Yalidate Help ‘Window

DRI e & g ?

al Remote Data Capture 00000000000 :

ew Search
adify Search
hiange Study

I 1= 1=

SCreening 1

ocreening octeehing

Fepors : 5
1] Enroll

Erirlt it 20 g : o on LY

Fefresh

Exit

Log out using Exit
1 1




Log Out

e Exit C3D before closing the Browser

e Inactivity for more than 30 minutes logs your
out automatically. Any unsaved work iIs
lost!
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Inserting New Patient

E%‘:DE?En Shah{Data management role) at OCTREN on D1-MAR-Z005 (Study:TRAINING Boolc:Dcoi Boolk)

File Edit Insert CRF Group Activities Validate Help ‘Window ORACLE

Choose Patient Position

]
= |
| |l
Icon to Insert New Patients

_ |
1.

WEE N

o |
TN | .
(4]

| ActivityList | All patients, all pages

SLmmaey =

aaaaaaaaaaaaaaaaaa
aaaaaaaaaaaaaaaaaaa



Inserting New Patient

e Click Patient Icon or Select Insert -> Patient from the
menu bar

e Choose a Patient Position Number from the pick list
e New Patient Row is Created

e Quick Tips:

o The total number of Patients available for entry are
governed by protocol ceiling accrual. Request additional
patient numbers if protocol is amended.

Q It is a good practice to use the patient numbers in sync with
those assigned by Central Registration Office (CRO)
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Starting New Planned eCRF

E%%Deven Shah{Data management role) at OCTREN on 01-MAR-Z2005 (Study: TRAINING Book:Dci Book)

File Edit Insert CRF Group Activities “alidate Help ‘Window ORACLE

Course 1

-C-:-urse 1 - o ] [ roe | - S ] - -
1z
FPhysical = ol e et

N

|20 ~|

20 (HHC)

N

Click on empty Cell to
insert eCRF and begin
data entry

ar . o
Activity List | Al patients, all pages

Summary

39



Starting New Planned eCRF

e Click on an empty cell to insert eCRF and
begin data entry

e Resize If necessary
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Entering Visit Date

E%‘:Deven shahi{Data management role) at OCTEN on 01-MAR-Z005 (Study: TRAINING B - |I:I|i|

File Edit Inset CRF Group Aclivities “alidate Help Window DI?AC I—E.

rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr
rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr

Urinaly=is Bone Mar ... Serology

Cther :

. SCreening
[

|1 -10 7 Prior T
C aysam | P=E
e Patient 4 Page & {Prior Tx for Screening)
izt Date |7|_ Blank [ <ommernt |
— PTH | Com

Bilank [

Enter date, or T for Today XY for Yesterday, L for Last entered (required)

Enter Visit Date and press Tab key

sit date entered.



Entering New eCRF

e Click on the empty Cell to insert appropriate eCRF
e Enter the Visit Date

Q

Q
Q

U

Visit Date is the Lab Sample Collection Date for Lab
eCRFs!

Visit Date is mandatory except for Ongoing Visit eCRFs.
Partial dates are not acceptable.

Consult eCRFs Instructions Manual for eCRF specific
guidance:

o Usually Evaluation Date, Administration Date, Initiation Date, Lab
Date, Course Start Date, etc.
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Entering Data in eCRF

Eﬁjﬁ'OPA (Marcelo Fontinha - OPS$FONTINHMT at OCPROD on 15-JUN-200-1)
File Edit | it CRF

G XD B O P S

Tabs Screening [ Course 1 Course 2  Course3 Courzed Course S  Blood Chemistry  Hemstology Urinalysis Bone Marrowve Serology Other Serum Blood Gas
| Patient X2 Page 2 (Enroll for Screening) Page 1 of 1. e
Wigit Date 10-Jun-2004 Blark [ Comment |

Enrolt || Init_ts | COb

LA WA FA .

Tabs for eCRF sections ey | \ 8
X2{XYZ)
— Fvctmert Non-enterable field =i

¥4 0vz)y | Gender |nT|:nate of Bith |0 -Jan-1973 Aoe ot Ertry Patiert Initials ABC
Diate of Registration 02-JAN-2004 Diate from wwhich to Start Including Labs 0S-h2y 2003 =

X8 (XN o
X9 (¥vZ) | Race: Select all that apply Indicates Pick List Ethnicity |NONHISPANIC
White 7 Registering Institution =
K10 (XYL H H
PV iackiarican american |N7 Local Patient I Ye”OW — Univariate
Mative Hawaiian/Pacific |slander |N_ Patiert Subgroup DISCFG pan Cy
Azian Registering Group [»

PR

Activity List | American Indian/laska Mative

Country Code AR _
Postal Code

Method of Payment Q5=

-

Summary Race Mat Repaorted

Race Unknown

=EE)

Primary Dizeasze Site S CULOZELET AL Dizeaze Code 10000537 Dizea=ze Stage at Entry STAGE N A

Histology/Cytopathology |xyz

Date of Confirmation of Histalogy Gracde of Histology 2
Date of Diagnosis Planned TAC |ARM 2

Use Tab '[0 move between ﬁelds 01 -JAM-2003 Date of Informed Consent “ersion 1 2-DEC-2002

eCRF Scroll Bar
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Entering Data in eCRF

e Navigating between Fields
0 Use Tab Key to move to Next Field
a Use Shift Tab to move to Previous Field
0 Use Mouse Click to navigate to a Specific Field

e Fields with Ellipsis indicate a Pick List (Use the Pick
List!)
e Enter Dates as
a Complete dates for Current Information (ex: 5/23/2014, 5-
23-2014 or 05232014)

a MMYYYY for Prior Information is acceptable when
complete date cannot be obtained (ex: 05-00-2014,
05/00/2014, 05002014 )
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Tabular eCRF

E%OPA (Marcelo Fontinha - OPS$FONTINHMT at OCPROD on 15-JUN-2004)

Tahs| Visit

X1 {XYZ)

Unlock

Az

X2{XYZ)

X3 (X¥Z)

X8 (X¥Z)

X9 (X¥Z)

¥10 {XVZ)

Activity List

5

Summary

X4 (X¥Z) |

“izit Date |1 G-Apr-2004

Patient X1 Page 46 (All Aes for Ae) Page 1 of 1, Repeat 5 of 10.

Blank [ Comment |

Number of Rows (Repeats)
allowed for entry and displayed
are set by Designers.
Table does not have scroll bar.

Use Up/Down Arrow Keys to
Navigate beyond the visible rows.

=

05-APR-2004 10-MaY-2004

Arthritis (non-septic)

MUSCULOSKELETALSORT TI

-

05-JA0-2004 20-J4M-2004

Abumin, serum-low (hypoal

METABOLICAABORATORY

ovhat

Arorexia

GAZTROMNTESTIMAL

01-h2N-2004 10-MaY-2004

Anorexia

GASTROMNTESTIMAL

G4

05-hd %2003 10-h AN 2003

Palpitation=

CARDIAC ARRHY THRLA

05 Lindke 2004 O0-ha 22004

Alkalosis (metabolic or respi

METABOLICALABORATORY

01 -JAR-2003 10 LMk 2003

Palpitations

CARDIAC ARRHY THRLL

02-FER-

01-FEB-2003

Bla
]
s
Day in Achferse Everts 7% ]
Course # Course Prior Date of Onset Diate Resolved CTC Term CTC Category Adverse Event Description E:'
1 304 01 -Jar-2004 05-J40M-2004 A LA SE / METABOLICALABORATORY AT
2 2 hi 02-JAr-2004 3-JA40-2004 Anorexia / GASTROIMTESTINAL it till
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Tabular eCRF

e Fields shown in a grid layout

e Scroll up and down the rows of the table using arrow
keys (No Scroll Bars!!)

e Quick Tips:
0 Use the menu option CRF -> Insert Row to insert a row
between two rows (below the currently selected row).

a A row cannot be left blank and must be deleted before
proceeding to another row.
o Select the menu option CRF -> Delete Row.
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Using Pick List

E*gji.Deven Shah{Data management role) at OCTRM on 01-MAR-Z2005 (Study: TRAINING Book:Dici Book)

File Edit Insert CR 1) date He - ORACLE

Patient 1 Page 35 (Adwv Event for Ongoing)

izt Date |(0T-Jul-2004 Blank | Comment [

Type | AE Click on Field Ellipsis or
Hit F9 to show Pick List

el -

Date AdEERS

Filexdd Grac

2= Res=aolved CTC Term CTC Zategary Acverse Event Description

s |

] INeurnnﬁ‘rhV' motor

L i

10{SAH}| | ey H % H ﬁ
[ Activity List ] All patients, all pages Bilirubin {tryperhilirubinemia)

Sumimany For

04 15353555

S

List ofvalu...
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Using Pick List

e Fields with Ellipsis contain a Pick List

o Eick List can be accessed by clicking the Ellipsis or pressing the F9
ey

e Searching the Pick List:
o Start typing in some letter and the list is filtered as you type or;

o Click on the Find box, enter a some letters surrounded by the wildcard %
character (ex: %ypo% ) and click on the Find button. Select one of the values.

o If the Pick List has more than 1,000 items, items beyond 1,000 cannot be
searched after the Pick List is shown. Close the Pick List and use the
wildcard find shown above then press the F9 key or click on the ellipsis. This
way the entire list will be searched and matched items shown. The following Pick
Lists have more than 1,000 items:

o CTCAE Term (version 3.0) pick list on the Adverse Events and Baseline Symptoms;
o Agents in the Concomitant Measures and Medications;

o Enrollment eCRF Disease Term (only when using comprehensive CTEP list of
Diseases);

o Enroliment eCRF Registering Institute;
Course Initiation eCRF Treating Institute.

e Quick Tips:

o If avalueis notin the Rick list enter it, consult your DM Supervisor. Entering

a value that is not on the pick list will create a discrepancy.

48



Marking eCRF Blank

E*gji.Deven Shah{Data management role) at OCTRM on 01-MAR-Z2005 (Study: TRAINING Book:Dici Book) O] =]

File Edit Insert CRF Group Activ Jalidate Help Window ; y e NC L&
B s Ty @ 4 k] ) Marking entire eCRF Blank

%o Clinical Remote Data Capture

Tabs Screening 1

. Patient 5§ Page 2 (Enroll for Screening)

E Wizt Date |l]3—lluu-2l]l]4
ey

Blank [ “Comment |

Type |Er | Blark W | }

This section has been marked as hlank

Marking Section Blanks

A e

wew!| S| M Bl | F | |
(4] = —————————————

Activity List | All patients, all pages

I

Summary

Patiert istt |Screening ]

Created on [DS-NDV-EDDEL 12:44:50
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Marking eCRF Blank

e Entire eCRF can be marked Blank
e Individual Sections of an eCRF can be marked Blank

e Checking Blank Flag will erase any entered information
from the eCRF/Section

e Blank Flag can be unchecked to enter information

e Quick Tip:
a It is a good practice to mark Sections that will not have data
entered as Blank.

a Once all sections of a CRF are ‘addressed’ (by entering data or
marking it as blank) the overall status of the eCRF becomes
Entry Complete.
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Entering/Viewing Laboratory Data

E;‘,Abu Muyeen({Data management role) at OCPROD on 23-FEB-2010 (Study:10_C_0056 Site:NCIMB Book:Book 0 11dec2009)

File Edit Insert CRF Group Activities Validate Help Window

Blood . | Broeess
| Disgresancy (manuzl) F1d f _ Chemstry ||

et Disascant 1 [IBiood ch..2 [Biood ch.3 [{Blood Ch.4 ‘ Biood Ch. 5 [{Blood Ch. & rl:j:bnnﬂ
R RN :m | Blood Chiem |fBiood Chem|§Blood Chem|{Biood Chem|§Biood Chem fpages

L E HENEN
1010001 (SES) ) (9 _H_Hﬁ

& ®| G | |
| Show/Hide

\ B UnH;IanneHJl J

I I [

—{ Add Unplanned |
T T | |

[0 | S —

4
Site NCIMB, Patient 1010001

Summary of CRFs Retrieved

Planned | _ 25| Mot verified 37|
Unplanned I I_g_i Awaiting re-verification | J
Total | 37 Werified | |

Summary of CRFs in Current Tab

Planned | 1] Not verified | 7|
Unpiannedl E_Ij Awaiting re--.reriﬁcatinnl
Total | 7 Verified | |
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Entering/Viewing Laboratory Data

e Laboratory Data eCRFs are designed with
dedicated Tabs (Hematology, Blood Chemistry,
Urinalysis, etc.)

e Additiona
clicking S

e Additiona

Lab eCRFs can be viewed by
now Unplanned Events

Lab eCRFs can be added by:

0 Select the appropriate Lab Visit;
a Open the patient’s last Lab eCRF on the selected visit;

o Then select the menu option Insert -> Visit
o Do not select Insert -> CRF
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Saving eCRF

E%%DE?EI‘I Shah{Data management role) at OCTRN on 01-MAR-2005 (Study:TRAINING Book:L - |EI|E|

File Edit Inset CRF Group Activities ‘“alidate Help Window ORACLE
B X NB IO Bl ?

%em Oracle Clinical Remote Data Caplure ol e T T T
Tal::us reening[ Courze 1 Courze 2 Blood Chem...  Hematology  Urinaslysis Bone Mar... Serology Cther Se.. E

Page 1 of 1. o

' Patient 5 Page 2 (Enroi for Screening)

E Wisit Date |ﬂ3-llc-'u'-2ﬂﬂ4

Blank [ Comment

Enroll | Init_vs = COM ‘
1 [=E B R
Blank =
Save Icon S
Amim
EMROLLMENT ==
Bt ﬁr Date of Bith — 113-APR-1995 Age st Entry |9.2 Patiert Inttials ~ |zaH B B
Date of Reaistration 22-JUN-2004 Diate from which to Start Including labs 18-JUr-2004 =
Race: Zelect all that apply = I
1| | ,
T TEvE] T TEvr) [ |
wean | | Bl | B =1 | | | -

_Record: 111 ... | Listofvalu...




Saving eCRF

e eCRF can be saved using
0 Toolbar Save Icon (yellow floppy disk)
a F10 Key
a0 File -> Save menu option

e Quick Tip:
o Save Often!! Especially while entering Ongoing
Information such as AEs and ConMeds.

o C3D session terminates without warning if there is
no activity for 30 minutes.
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Data Entry Change Reason

E%?DE?EI‘I Shah{Data managenment role) at OCTRN on 01-MAR-Z005 (Study:TRAINING Boolk:Dci BEool) - |EI|E|
File Edit Inset CRF Group Activifies Validate Help Window ORACLE
G GRS g2

! !
"rm Oracle Clinical Remote Data Capture

Tahs Screening T T " Audit Infarmation far Data Change

el e Change Reason Description

Patient 5 Page Z_ [Enrnllfnr Screening) P-a-é-e 1 DATA ENTEY ERR
isit Date Blark [ Diata Entry Error \

Comment

EMROLLMEMT

Gender Ciate of Birth

Date of Registration

e
18-JUn-2004

01011967

22-JUr-2004

Digte from which to Start Including labs

Race: Select all that apply Data Changed

aaaaaaaaaaaaaaaaaaaaa
aaaaaaaaaaaaaaaaaaaaaa

Fecord: 11 =05C=

55



Data Entry Change Reason

e Change Reason needs to be specified while
changing data on completed eCRF

e Change Reason becomes part of the Audit Trall
along with date of change and user name

e Comments can be provided in the change reason to
further explain

e Quick Tip:
0 Do not use personnel/patient names or identifiers in the
comments.
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What Is a Discrepancy?

e A discrepancy is the failure of entered data to pass a
validation check as applied by C=D.

e C3D validation checks are defined based on the definition of
the fields, logical rules, protocol specifications, and sponsor
requirements.

e Discrepancies are tools to assist teams in identifying

potential data inconsistencies and facilitate real-time QA of
data.

e Quick Tips:

a Discrepancies do not cover 100% of possible data
Inconsistencies.

o Clinical judgment may supersede discrepancy logic.
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C3D Discrepancy Types

e Univariate

0 Generated during data entry/load when data is in some way
different from the Question’s definition (e.g. mandatory, length,
type, range, pick list, etc.)

e Multivariate

0 Based on a condition on one or more questions as defined in a
validation rule

a Generated on-line or when validation rules are run (eCRF must
be saved as Complete.)
e Manual

0 Generated by data entry operator seeking clarification on data
values
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Some Typical Discrepancies

Types

Example:

Resolutions

Data Type Text entered in numeric or date | Review Source Document and
field. enter appropriate data.

Length Too many characters entered. Use NIH accepted

Problems Abbreviations.

Value not on Generic Agent not present in Search for alternates.

the P|Ck L|St Concomitant Agent Pick List Consult Team Lead.
?nd gser tﬁpepd_ ”;( if‘ Agent not Request value to be added to
ound on the Pick List. Pick List.

Mandatory Required Field left empty. Refer to Source Document.

Value

Design modification.

Partial/Invalid
Dates

00-10-2010 entered, but field
requires a full data such as 01-
01-2010

Refer to Source Documents.
Check Day Month Year order.

Check that date is not in the
future.
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Outstanding Discrepancies in a Study

=2 Deven Shah(Data management role) at OCPROD on 18-JUN-2004 (Study: THER_STD Site:SITE_01 Book:Whole Book)

Eile Edit Insert CRF Group Activities Yalidate Help Window

213 T Elh >l S ol ?

%em Wy Activity List

=-THER STO | Review 49 Active Discrepancies -
éa-.gite; 2ITE 01 Showe All Data for THER STD

Feview 49 Active Discrepancies for Site SITE 01

Change Study ]

Search ]
Cancel ]
- Help ]

[ SUMMAEFy

60



Outstanding Discrepancies in a Study

e Total number of Discrepancies in a study are
shown in the Activity List

e Clicking on the ‘Review xx Active
Discrepancies’ link will present only the
Discrepant eCRFs

e Quick Tip:
o Data Managers should manage their

discrepancies every morning to help ongoing QA
of data.
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eCRFs Containing Discrepancies

Eﬂl Deven Shah(Data management role) at OCTRN on 20-JAN-2004 (Study:THER_STD S5ite:SITE_01 Book:Whole Book)

File Edit Insert Go Validate Data Entry Help Window
S HPLHXDOB ¢ 3 v« 23T 792

’E}J Oracle Clinical Remote Data Capture

Tabs Screening l Course 1 Course2 Course 3 Coursed4 Course 5 Blood Chemistry Hematology  Urnnalysis  Bone Marrow £
Visit .Srsreenfng .Srsreenfng .Sr:menfng .Srsreenfng .Srsreenfng .Srsreenfng .Srsreenfng .Srsreenfng .Srsreenfng Scre
Page 1 2 3 4 5 6 7 8 9 10
CRF  Elig Enroll MRN Medhist Symptom  Prior Thrp  Prior Tx PriorRad  Prior Surg | Phys

IF;T:nt = = i = E = E — =
o 18 W B H W W W[E

15 (No inits)
— : : eCRF Containing
|5I (Mo inits) . . .
Unreviewed Discrepancies
10 (ABC) E are displayed as Red

4|
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eCRF Containing Discrepancies

e eCRF containing discrepancies are shown In
Red

e |t IS a good practice to address discrepant
eCRF on an ongoing basis
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Discrepancies Tab

1 |

N Patient 1 Page 5 (Symptom for Screening) Page 1 of 1, Repeat 1 of 2.

-




Discrepancies Tab

e While viewing an eCRF, clicking on the
Discrepancies Tab shows the discrepancies
on that eCRF

e The first tab gives the summary of all
discrepancies in that eCRF (open and
closed)

e Additional tabs provide individual
discrepancies detalls.
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Discrepancy Detalls

Ei Deven Shah(Data management role) at OCTRN on 20-JAN-2004 (Study:THER_STD S5ite:SITE_01 Book:Whole Book)
Eile Edit Insert Go Validate Data Entry Help Window

racle Clinical Remote Data Capture

Tabs|Visit | | Urinalysis | Bone Marrow t 2 Page 105 (Offstudy for Offstudy) Page 1 of 1.

Visit Offstudy | ' | Visit Date [25-Mar-2003 Blank™ . Comment |

Page 105 =
CRF  Offstudy Ossm* | COM

Patient Blank!™ _ -
1L =]
2 (PT) i Date Study Treatment Complsted |19-I\-‘1AR-20[]3

5 (Mo inits)

Reason for off treatment P= Reason other CLINICAL DETERIORATIOMN
9 (Mo inits)

10 (ABC) E Date Off Protocol Follow-up |
1
Search Site SITE_01 =

1] | =
Summary Discrepancies [ Verification Approval Audit Trail Links

-| DBest Response to Treatment

Each Discrepancy Detalil is in following tabs

| Date of Progression |[J3-SEF'-2002

List 1 - Active |

|| |Best Response to Treatment is checked as 'PR=PARTIAL' on the Off Study Summary form, but Date Onset of Best Response is missing. Please Status : Discrepancy not reviewed by 1 Id - 8375801

Comments Action -] History | Resolution Comments and Reason |

n— - J\ Disc History is available via this button

|The patient’s disease state as of the la |F’R=F’ARTIAL =]

|The date a response was first observed. |

| | -
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Discrepancy Detalls

e Subsequent tabs show detalls for each
discrepancy

e Open Discrepancies are displayed first and
are followed by Closed Discrepancies

e Quick Tip:
0 Double Clicking on the Discrepancy Text brings up
a pop-up box with the entire message
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How are Univariate Disc. Created?

E_% Deven Shah({Data management role) at OCTRN on 20-JAN-2004 (5tudy:THER_STD Site:SITE_01 Book:Whole Book)

File Edit Insert Go Validate Data Entry Help Window

RS XDB v s v+ 2T O L2 Univariate Disc Pop-up
& *%a Univariate Validation Failure -/~ el
Tabs Visit - |  Screening | Course 1 Course 2 Course
Univariate Failure Reason:[THESALRLUS

Visit Sereening | Secreeming | Screening

Page 1 Message|\/alue of HDOFHHDFHF far The Common Toxicity Criteria

CRF ENg Enroll MRN Term is not in the lookup thesaurus . L.
Patient I I % ——— DeSCI’Iptlon Bls
1(L) = = i

I I Comments
2(PT) = i
I
5 (Mo inits) ﬂ %
I I
9 (No inits) /QGK Cancel
10 (ABC) E Status:
. Action: | |
Alternatively, operator can e o SRR G e e e
. . . eview us:  UNREVIEWED
accept to create univariate disc _ P .
Resolution Code: create the discrepancy
Resolution Comment: %
1
Search Site SITE_01
Summary Discrepancies Vermhcation Approval Audit Trail
List 1 - Active

Seq Text Status Comments
L — S — T ——
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How are Univariate Disc. Created?

e Univariate Discrepancies pop-up is presented during data entry
when the entered value does not match the field definition.

o 0o 0 o

Q

Mandatory field left empty

Text entered in a Date or Numeric Field

Too many characters entered

Value is not on the Pick List

Partial Date entered when a complete date is required

e Data Entry operator can:
a Cancel the pop-up and fix the value
o Or accept the discrepancy

e Quick Tip:
0 Univariate Discrepancies are reassessed during Batch Validation for Design

Changes.
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How Is a Univariate Disc. Displayed?

Ei Deven Shah(Data management role) at OCTRN on 20-JAN-2004 (Study:THER_STD Site:SITE_01 Book:Whole Book)

File Edit Insert Go Validate Data Entry Help Window
G POSXKDB & & - 2 3 Y F o ?

";_El ‘Oracle Clinical Remote Data Capture

Tabs Screening | Course 1

Course 2 Course 3 Course 4 Course 5 Blood Chemistry Hematology — Urinalysis

Visit Screening 'Screem'ng | Screening 'Screem'ng | Screening 'Screem'ng | Screening 'Screem'ng | Screening 'Screem'ng
Page 1 2 3 4 5 6 7 8 ] 10
CRF  Elig Enroll MRN Medhist Symptom Prior Thrp Prior Tx Prior Rad Prior Surg | Phys Sem
o (BBl | =5 = =]
10 =5 | =i =i ] =] =] =]
E [ 1] i E Patient 1 Page 5 (Symptom for Screening) Page 1 of 1, Repeat 1 of 2. %
2 (PT) = Visit Date [25-\ar-2003 Blank™ . Comment |
5 (No inits) E Bsym" | COM
Blank[™ .
S 0o i) m ] - - \
10 (ABC) i =
| Onset Date CTC Term Symptom Description Grade Rel
| r |HEF'ATIC:: BILIRUBIN |AEIC 2=N( r
] 20-JUL-2002 HDFHHDFH vz 1=MI B
| | TN J L
— I I I Data Values with Univariate
o |EeEmr a Discrepancies is highlighted
Summary Discrepancies l Verification Approval RO T TS
List | 1-Active
Seq Text Status Comments Action

-|Value of hdfhhdfh for The Common Toxicity Criteria Term is not in the lookup thesaurus repancy not reviewed by |

=
| - |

I

|
|

—
—

Data Values with Univariate
Discrepancies is highlighted

‘ .
I
I
I
]

New History 1]

Bone Marrow  Serology Other Serum Blood Gas  Red Cell Ind... v
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How Is a Univariate Disc. Displayed?

e Discrepant data is highlighted in Yellow
e Discrepancy text provides the details

e Quick Tip:
a Double Click on the Discrepancy Message Text to
view the entire message in a window.
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How are Multivariate Disc. Created?

e Multivariate Discrepancies are created based on validation rules
programmed in a study
o Example 1: Create Discrepancy if the entered BSA is not within 10% of the
calculated BSA
0 Example 2: Create Discrepancy if Date of Histological Confirmation is
before Date of Diagnosis

e Quick Tip:
0 Rules available as a standard on each eCRF are summarized in the eCRFs
Instructions Manual.

0 Though several standard rules are implemented for each eCRF as specified
on the eCRFs Instructions Manual, clinical teams can request them to be
turned off or modified to comply with the Protocol.
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Evaluation of Multivariate Rules

e Validation Rules are evaluated:

0 on-line validation rules are evaluated upon completion of a CRF
Saved as Complete

a during an overnight batch validation session for CRFs Saved as
Complete

e Multivariate Discrepancies are displayed in the same
manner as Univariate Discrepancies. The Discrepancy
Detalls panel indicates the type of Discrepancy.

e Quick Tip:
0 Complex rules run overnight.
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How iIs a Multivariate Disc. displayed?

ORACLE

..S‘creen.l'ng
2
Envalf

Patient 10 Page 2 (Enroll for Screening) Page 1 of 1.

Wisit Date (03-Ho 004
e D

Blank [ Commert |

e

Primary Disease Site lEIONE hl & RRChY Diseaze Term ACUTE LYYMPHOCY TIC LELUKE  Disease Stage at
HizstologywCytopsathiology |Per3isterrt Recurrent Acute Lymphotic Leukemis
Date of Confirmstion of Histology .E|1 -Jir-1999 Grace of Histolocy
Date of diagnosis '|:|'1 -DEC-2000 Planned TAC .

1| Date Informed Consent Sioned .22_.J|_|N_2|3|:|4 Date of Informes-Sonze Dlscre pan Cy tab

=l
LT 1 Foeaees
l:hllll:y s U POUSILD, Ol Paysa Discrepancy

Dii ETENCIES

Description

Sl Discrepancy not reviewed b

45113401

lLie:
01-Dec-2000
The date when lesion was histologically 01-Jun-1999 | B

Diate & new, unigue malignant neoplasm or
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How iIs a Multivariate Disc. displayed?

e Discrepancy is based on one or more fields and is
NOT highlighted in Yellow

e Discrepancy tab provides the detalils

0 Discrepancy Text
a0 Involved Clinical Data in the evaluation of the Discrepancy

e Quick Tip:
a The Action pull-down “Go to Data Field” does not work as
the discrepancy could be based on more than one field.
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How to Address a Discrepancy

Ei Deven Shah(Data management role) at OCTRN on 20-JAN-2004 (Study:THER_STD Site:SITE_01 Book:Whole Book)

File Edit Insert Go Validate Data Entry Help Window

"gg Oracle Clinical Remote Data Capture |

Tabs Screening [ Course 1

Score ening ‘Screenin, g 'Screenfng 'Sareenfng -Screem'ng Scre ening -Screenfng 'Screenfng ‘Screenin, g
5 7 8 9

Visit  Screening
Page 1
CRF  Fiig

Enroll

Course 2 Course 3 Course 4 Course 5 Blood Chemistry Hematology  Urinalysis

Bone Marrow  Serology Other Serum  Blood Gas  Red Cell Ind

10

MRN Medhist Symptom Prior Thrp Prior Tx Prior Rad Prior Surg Phys Scrm

Patient

1)

LHEE

2 (PT)

E = \fisit Date [25-Mar-2003

5 (Mo inits)

Bsym™ [ com

9 (Mo inits) E

| Patient 1 Page 5 (Symptom for Screening) Page 1 of 1, Repeat 2 of 2. <Univ=

Blank™ . Comment |

10 (ABC)

B (O LHCHER

E—

Choose Go to Data Field from Pu

Blankl - ‘

Il Down Menu \

——

L = Grade
‘ |UU-SEF'-2[J[]2 |HEF'ATIC:: Bilirubin |AEIC \ 2=
‘ |20dUL-2002 |hc|fhhclfh |)(YZ \ 1=

I

[

I i |

Fix Data as indicated in the Discrepancy Text

1 |

Search Site SITE_01

L

Summary

List | 1-Active
Seq Text

Discrepancies l Verification

Approval

Status Comments

.|Va|ue of hdfhhdfh for The Common Toxicity Criteria Term is not in the lookup thesaurus

Audit Trail

|Di5crepancy not reviewed by

| ]|

Send to site
Send for classification
Close - resolved

Closed - no resolution
Go to data field

New

History




How to Address a Discrepancy

e Review Discrepancy Detalils

e \Whenever possible, use the Action pull down ‘Go to Data
Field’ to jump to the Discrepant Field

e Resolve the discrepancy by:
a Consulting Source Documentation and,;
0 Modifying incorrect data and specifying change reason;
0 Requesting eCRF Design and/or Validation Rule Change.

e Quick Tip:
0 System obsoletes univariate discrepancy automatically when
data is corrected and complies with design/rules.

0 Multivariate Discrepancies are only re-evaluated during overnight
Batch Validation.
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Verification & Approval

" RO Topics

lcon Explanation

Blank i_reated Ertry stated Entry complete Pazzs 2 started Pass 2 complete Batch Loaded

[ ] | Jhivul I |
-« [l Nl BSl W=

: [ TCow [T
Digcrepancies: Sctive . I Tther E’

Fequires

“Yerification:
Fe-verification

“erified

_ Requires itz -
Approval: Re Ligircvsl !Fﬂ Approved .

Locking: Locked

I




Verification & Approval

e C3D Verification & Approval functionality
offer capabillity to track QA and Monitoring of
eCRFs.

e Verification functionality is available for users

wit

e Ap
Wit

N Research Nurse account role.
oroval functionality Is available for users

N Monitor account role.
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Verification

E%Deven Shah({Data management role) at OCTRM on 19-SEP-2005 (Study:TRAINING Book:Dci Book)

Eile Edit

-0 x|
ORACLE

Enrall fo

1 {BJS)
2 (SB) Patient 1 Page 2 (Enroll for Screening) Page 1 of 1.
— “izit Date |2l] May-2004 Blank [ Comment |
3 (SKY)
4 {GB)
5 (FB)
EMEOLLMERNT
6 (WC)
T (FH) Gender |m | Drate of Birth 24-0CT-1953 Aoe at Entry o .
Date of Registration -1 9-hd A -2004 Dot wvhi Verlflcatlon Tab 2004
8 (TL)

comment ([, <

Verify Button
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Verification

e Each eCRF can be verified by clicking on the
Verify button

e Verified eCRF Icon has a Checkmark &

e Editing a verified eCRF changes its icon to a
Re-Verify status &

e Edited eCRF can be re-verified

e eCRF Verification Change History Is

maintained Iin the Verification pop-up
Window
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Verification

E%%DE?EI‘I Shah{Data management role) at OCTREN on 19-SEP-2005 (Study:TRAINING Book:Dci Book)

File Edit Insert CRF Group Activities Yalidate Help Window

W XDRBRI Ol g2

"m Oracle Clinical Remate Data Capture

Tal::nsl Wisit - | =Creening l

Soreening  WSHGESAVEEN Screening Il Screening Wl Screening W Screening M Screening [l Soreening
2 4 : & 7

Enroll MRN Mecthist Slerrg Priar Tx Prior Thep | Prior Rlad

1{BJS)

2 (5B)

3 (SKY)

Re-verification | -
Required

4(GB)

5 (FB)

Verified eCRF

& (WC)
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Verification

EﬂDeven Shah{Data management role) a TRN on 19-SEP-2005 {Stud - |EI|5|

=T iti idate  He : OoORrRACLE
LB XD B N S

] linical B ture

Tabs Screeningl

1-8 -
1{BJIS) g5 |
g
2 (SB) % Patient 1 Page 2 (Enroll for Sereening) Page 1 of 1. ES
==t
—c L Wisit Date |2 May-2004 Blank [~ Commernt |
= | crvor | (mLve. | oM
4 {GB) %
===
5 {FB) %
= IROLLMENT
& (WC) ___E
===
T (FH) %‘ der |m | Dste of Birth [24-0cT-1353 Age ot Entry |50.5 Pattient Intials lBus
—O T L —————
= of Redistration 19-m2 Y -2004 Date from which to Start Including labs 05-hoYy - 2004
8 (TL) %I
==
4
G = Select all that spgly

------------ Re-verify Button

Merification

peration

19-SEP-2005 16:45:28  |Werify Cewven Shah

§19-Sep-2005 16:43:28
commert (A =
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Approval

E.%Deven Shah{Data management role) at OCTRMN on 19-SEP-2005 (Study:TRAINING Book:Dci Book) - |I:I|5|
File Edit Insert CRF Group Activiti idate Help ‘ ORACLE
G MBI

| Remaote ture

Screening 1

s - Approved
e =il 1l
r —n
2(SB) Patient 1 Page 4 (Medhist for Sereening) Page 1 of 1. %
“isit Date |2l]—May—2l]l]4 Blank [ <omment |
3 (SKY) Brmeh | coM
4 (GB) .
Re-Approval required
5 (FB)
BASELIME MEDICAL HISTORY
[
wey Date of Examination
7 Approval Tab
Body System Medical History If &bnormal
8 (TL
(o HEEMIT SIMUSITIS, R-SIDED HEARIN% HEAD TIGHTHEZS, MULTIPLE DEMT AL

Approval

Approval Password
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Approval

e Each eCRF can be approved clicking on the
putton and providing your C3D

Approve
PasSSWOrC

e Approvec

e Editing an approved eC
to a Re-Approve status |.E

eCRF Icon has a Signature

e Edited eCRF can be re-approved

e eCRF Ap

maintained in the Approval pop-up Window

proval Change History Is

—
pr— . |

RF changes its icon




CRIS to C3D Lab Data Flow

Lab Mapping

WBC Count WBC _SERUM
Basophils BASO
Hemoglobin HEMOGLOBI N
WBC Morphology ???




What is LLI?

e LLI Is a utility to review and identify specific
Lab Test Results to be downloaded from the
CRIS/CDW into C3D

e URL:

e Username & Password are same as C3D
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https://octrials.nci.nih.gov/opa46/labloadinter.htm

LLI Search Screen

Eg;’,i'Lah Load Interface

Search 1

— Zearch Criteria

Lab Load |Interface
Lab Panel Search

Workflow

Search Criteria

Selected Panels

Action Buttons

Sty Ft Lak Panel Z30 Test Mame Date Relstion DD MOR ™Y
| . | = . —— Search
Titne Relation HHz24 il
[ v] | | Meswy Search
~—— Search Results
Select Al | Unsslect Al |
Stucly ] Lak Panel ] Sample DateTime ] \
L I I I 2]
= I I I
] | | | | Move Panel(z] to Load Cart ]
= [ [ [
= [ [ [
l_ | l l l Move Panel(s) to Archive ]
= I I I
o l l l l i All Lakbs for P | and Dt
= | | | | =0 sk for Panel an & ]
| I I I
= I I I
= I I I
= I I I
= I I I
= [ [ [ =)
Exit
Record: 11 List afvalu... QSC
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LLI Search Criteria

search Criteris

Study Pt Lak Panel 3D Test MName Date Relation DO MOM Y5y
|| el | ol | | ] | Search
Time Relation  HH24 M
- | | Mewy Search

« Searching
— Can search by Study, Patient Number, Lab Panel, OC Lab Question,
Date and/or Time

« Each search field contains Pick List.

« Date and Time allows the ‘%’ wild card

« Date and Time provide the additional option of:
* “On or Before”, “On or After” and “LIKE” comparisons
« Partial dates can be entered as %NOV%
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LLI Search Screen Results

Search Results
Select &l | Unselect 20 |

Sty | Pt | Lak Pansl | Sample DateTime

[¥

Move Panells) to Load Cart |

Mowve Panel( =) to Archive |

SN e

Wiewe Al Labs for Panel and Date |

e Search Results

The result set lists Lab Panels that have at least one lab test available
for loading that meet the criteria entered into the search fields.

The sort order can be changed using the column headings.

Results can be selected/deselected for processing by using the
individual select check box or Select Buttons.

Entire panels of lab tests can then be moved to the Load Cart or
Marked for Archive.

Clicking “View All...” button or by double clicking the record presents
the Work Cart with specific Lab Test Results for that panel.

90



LLI Work Cart

Yaork Selection

YVUIIK oAl L

Study Pt Sample Datetime Lakb Panel

Selection Results
Select &1l | Unselect &l |

| 30 Test Mame | Re=ult | it | Range | Status Load Flags
L[|

T Review
T issing
" Loaded
T hdarked
T Others

[»

e Work Cart

Shows Entire Panel, including previously loaded and missing Lab Tests
The list can be filtered using the “Load Flag” radio buttons.
Sort by Lab Test Panel Order (R), Test Name, Results, etc.

Results can be selected/deselected for processing by using the
individual select check box or Select Buttons.

Once selected, the lab tests can be moved to the Load Cart or Archived

91



Questions?
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